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This document describes what we tested, how we tested, and what we found. To learn how these facts translate
into real-world benefits, read the report Complete complex tasks in much less time by using Al technologies on
new PCs featuring AMD Ryzen processors.

We concluded our hands-on testing on January 23, 2026. During testing, we determined the appropriate
hardware and software configurations and applied updates as they became available. The results in this report
reflect configurations that we finalized on December 23, 2025 or earlier. Unavoidably, these configurations may
not represent the latest versions available when this report appears.

Our results

To learn more about how we have calculated the wins in this report, go to https://facts.pt/calculating-and-highlighting-wins.
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Using Al vs manual approach on an ASUS Zenbook S16

Table 1: Time to complete tasks on the ASUS Zenbook S16 with and without Al. Source: PT.

Task Time without Al Time with Al Time saved Time saved
hh:mm:ss hh:mm:ss hh:mm:ss Percentage

Generating and scheduling tasks 0:08:50 0:01:06 0:07:44 87.5%
from emails
Summarizing a meeting transcript 0:38:52 0:01:35 0:37:17 95.9%
Reviewing Jira tickets 0:20:19 0:01:43 0:18:36 91.5%
Creating a project plan 0:30:14 0:11:07 0:19:07 63.2%
Creating a Gantt chart in Excel 0:07:55 0:02:14 0:05:41 71.7%
Updating a presentation 0:03:09 0:00:59 0:02:10 68.7%
Managing client communication and o no.

. . 0:19:00 0:09:52 0:09:08 48.0%
scheduling meetings
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Using Al on an ASUS Zenbook S16 vs using a manual approach on an ASUS Zenbook 15

Table 2: Results of our testing. Less time is better.

ASUS Zenbook™  ASUS Zenbook 15 Time saved Time saved

S$16 UM5606G OLED UM3504DA hh:mm:ss Percentage
Time to complete task (mm:ss) with Al without Al
Generating and scheduling tasks 0:01:06 0:09:47 0:08:41 88.7%
Summarizing a meeting transcript 0:01:35 0:40:35 0:39:00 96.0%
Reviewing Jira tickets 0:01:43 0:20:44 0:19:01 91.7%
Creating a Gantt chart in Excel 0:11:07 0:30:14 0:19:07 63.2%
Updating a presentation 0:02:14 0:08:39 0:06:25 74.1%
S“ﬂf}gg%}?fgi';ir:t;‘;”;mu”ication and 0:00:59 0:03:19 0:02:20 70.3%
Drafting a document 0:09:52 0:19:32 0:09:40 49.4%
Total 0:28:36 2:12:50 1:44:14 78.4%

Table 3: Results of our testing extrapolated over a workweek. Less time is better.

ASUS Zenbook  ASUS Zenbook 15 Time saved Time saved
$16 UM5606G OLED UM3504DA hh:mm:ss Percentage
Estimated
Time to complete task (mm:ss) iterations with Al without Al
per week
Gengrating and scheduling tasks from 5 0-05:30 0-48:55 0:43:25 88.7%
emails
Summarizing a meeting transcript 5 0:07:55 3:22:55 3:15:00 96.0%
Reviewing Jira tickets 10 0:17:10 3:27:20 3:10:10 91.7%
Creating a Gantt chart in Excel 1 0:11:07 0:30:14 0:19:07 63.2%
Updating a presentation 1 0:02:14 0:08:39 0:06:25 74.1%
Managing client communication and 1 0:00:59 0:03:19 0:02:20 70.3%
scheduling meetings
Drafting a document 50 8:13:20 16:16:40 8:03:20 49.4%
Total (hh:mm:ss) 8:58:15 24:38:02 15:39:47 63.5%

Testing productivity while simultaneously running a large language model

Table 4: Procyon Office Productivity benchmark scores while simultaneously running an LLM on a current AMD Ryzen Al processor-powered
PC (equipped with a GPU and an NPU) and a previous-gen PC (equipped with a GPU). Higher is better. Source: PT.

Procyon Office Productivity ASUS Zenbook S16 with NPU ASUS Zenbook 15 with GPU Percentage improvement

Overall Rating - Median 6,818 4,374 55.8%
Word Score 7,883 4,888 61.2%
Excel Score 6,057 3,749 61.5%
PowerPoint Score 7,749 5,296 46.3%
Outlook Score 5,007 3,257 53.7%
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System configuration information

Table 5: Detailed information on the systems we tested.

System configuration information ASUS Zenbook S16 UM5606G ASUS Zenbook 15 OLED UM3504DA

Processor

Vendor

AMD

AMD

Model number

Ryzen™ Al 9 HX 470 CPU w/ Radeon™ 890M

AMD Ryzen 7 7735U w/ Radeon 680M

Core frequency (MHz) 2,000 2,700
Number of cores 12 8
Cache (MB) 36 16
Memory

Amount 32 32

Type LPDDR5 LPDDR5
Speed (MHz) 8,533 6,400
Integrated graphics

Vendor AMD AMD

Model number

AMD Radeon 890M Graphics

AMD Radeon 860M Graphics

Storage
Amount (TB) 2 1
Type SSD SDD

Connectivity/expansion

Wired internet

Via USB-C adapter

Via USB-C adapter

Wireless internet

MediaTek® Wi-Fi 7 MT7925

MediaTek Wi-Fi 6E MT7922

Bluetooth Bluetooth® 5.4 wireless card Bluetooth 5.3 wireless card
USB 1x USB 3.2 Gen2 Type-A 1 USB 3.2 Gen 2 Type-A
2 x USB 4.0 Gen 3 Type-C (USB Display/Power | 1 x USB Type-C Gen 1 (USB Display/Power
Delivery) Delivery)
1 x USB Type-C 4.0 Gen 3 (Display/Power
Delivery)
Video 1 x HDMI 2.1 TMDS 1 x HDMI 2.1 TMDS
Battery
Type 4S1P 4S1P
Size 4-cell 4-cell
Rated capacity (Wh) 83 67
Display
Size (in.) 15.6 15.6
Type OLED OLED
Resolution 2,880 x 1,800 2,880 x 1,620
Touchscreen Yes No
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System configuration information

ASUS Zenbook S16 UM5606G

ASUS Zenbook 15 OLED UM3504DA

Operating system

Vendor

Microsoft

Microsoft

Name

Microsoft Windows 11 Pro

Microsoft Windows 11 Pro

Build number or version

10.0.26200 (Build 26200)

10.0.26200 (Build 26200)

BIOS

BIOS name and version

American Megatrends International
UMS5606GA.201

American Megatrends International
UM3504DA.312

Dimensions

Height (in.) 0.51 0.62
Width (in.) 13.92 13.97
Depth (in.) 9.57 8.92
Weight (Ib.) 3.4 3.09
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How we tested

Initial system setup for all scenarios

AMDTest folder

1. Download and extract the folder to the C drive.

Installing AMD Adrenaline

Go to https://www.amd.com/en/support/download/drivers.html to get the latest AMD Adrenaline application.
Click Download Windows Drivers.

Open the executable, and proceed with installation.

Click Accept & Express Install to install the necessary drivers.

Wait for the installation to finish.

Restart the system when prompted.

A

Generating and scheduling tasks from emails

Installing and setting up Lemonade

Download Lemonade Server from https://lemonade-server.ai/.
Launch the installation and use the default settings throughout the installation.
At the end of the installation, select the option to Run Lemonade Server now.

AN

Wait 10 to 20 seconds for the Lemonade notification to pop up in the lower-right corner of the screen. Lemonade server is now running
in the background.

If Lemonade isn't running, manually launch it through the Windows search bar.
In the taskbar, right-click the Lemonade icon, and select Open app.

In the search field in the left sidebar, type L1lama-3.2-3B-Instruct-Hybrid
Select the download button next to the model.

0 0 N o

When the download completes, load the newly installed model Llama-3.2-3B-Instruct-Hybrid by clicking on the play icon next to
the model name.

Installing Belt

Download the Belt-Desktop-0.1.4.6 executable.

Install Belt.Al, choosing the default settings throughout the installation.

Two installations will occur. Allow the Belt Agent installation to complete before launching Belt Desktop.

Two installation instances will run in parallel. Wait until the Belt Agent installation is complete before launching Belt Desktop.

This is the Belt login page; do not log in yet.

Before logging in, switch to the production server by opening the taskbar popup and right-clicking the Belt Desktop app.
Under the Environment drop-down menu, select the Prod US option. This will relaunch the Belt application.

Log in with your account.

1
2
3
4.
5. Close the Belt installation when it completes. This will open the login page in the Belt Desktop app.
6
7
8
9.
10. Close Belt.

Al-enhanced workflow

1. Open Belt.

2. Simultaneously start the stop watch and open the Mail page in the application. Under the Al Labels section on the left
sidebar, click Missed.

3. Find the Pippin Fiesta email, and open it.

4. Click the Ask Al - Local button to ask questions and create tasks related to the email.

5. This opens a new chat with the email as an attachment for context.

6. Provide the following prompt to break the tasks mentioned in the email into subtasks:

Break the tasks mentioned in the email into subtasks.

7. Press Enter.
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8.  Copy the Al generated answer by clicking Copy.

9. Go back to the email by clicking on Mail from the horizontal navigation bar located at the top.

10. Open the Pippin Fiesta email again.

11. Click Task to create a task. Al auto generates fields including title and description based on the email.
12. Paste the previously generated Al response to replace the current description. Fix any formatting errors.
13. Click Save.

14. Go to calendar page by clicking Calendar on the top navigation bar.

15. View your tasks by clicking Tasks on the left sidebar.

16. Click Task to open the Task popup.

17. Click Show more >.

18. Click the ... button top right to open the drop-down menu. Click Convert to Event.

19. This changes the popup to the event creation popup. Create the new event by clicking Save.

20. Click Planner on the left sidebar to open your planner.

21. When the newly created event is displayed, stop the stopwatch.

22. Record the time.

23. Repeat steps 1 through 22 two more times.

Traditional workflow

1. Open Outlook.

2. Simultaneously start the stopwatch and search for the email titled Pippin Fiesta. Open the email, and note down the tasks.
3. Write down the relevant information, and prepare a list of subtasks to be completed.

4. Find free time to work on the tasks by looking at the calendar and assigning time slots for new tasks.

5. Select Calendar.

6. Create three tasks by left-clicking on three different calendar days and times.

7. Enter the relevant information in the popup, and click save to create three different tasks.

8.  Right-click a spot on the calendar, and select New event.

9. Enter the relevant details in the New Event window.

10. Simultaneously stop the stopwatch and click Save.
11. Record the time.
12. Repeat steps 1 through 11 two more times.

Summarizing a meeting transcript

Installing and setting up Lemonade

Download and install Lemonade Server from https://lemonade-server.ai/.

Place the LFM2-2.6B-Transcript-1-GGUF model file in a folder titled Liquid in the Downloads folder.
In Windows Search, type CMD

With the Command Prompt highlighted, select Run as administrator.

In the Command Prompt window, type

akrwbdh =

lemonade-server serve -extra-models-dir C:/Users/Username/Downloads/Liquid and press Enter.

6. In the Taskbar, right-click the Lemonade icon, select Load Model and choose extra.LFM2-26B-Transcript-1-GGUF.gguf.

Setting up Generate Al
Note: Before proceeding, make sure Lemonade is running.

Launch the generateinstaller1216.exe file.

Click through the installation using the default selections.

After installation, launch Generate.

After the application loads the Register page, enter your username, password, and license key.

arwDN -

Close Generate.
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Al-enhanced workflow

W o NGk wWwN =

10.
11.
12.
13.
14.

15.

16.
17.

18.

19.
20.
21.
22.
23.

Launch the Lemonade-server application.

In the Taskbar, right-click the Lemonade icon, select Load Model, and choose extra.LFM2-26B-Transcript-1-GGUF.gguf.
Select the Generate AIPC menu in the lower-right corner, and select Settings.

Select the Card Manager tab.

Select the New Card + button on the lower right side. It will open new screen to edit a card.

In Category, select General.

Select the icon field, and choose an icon from the window that appears.

In the tile field, enter Meeting Minutes Creator

In the description field, enter

The card will ingest your meeting transcript or notes and then be able to generate full meeting
minutes report.

In Step 1, choose Pick Integration for select a tool.
Select Add Another Tool, and select Pick File.
Select Step 1 for Select a step to pick integration.
Select Add Another Tool, select Get User Input.

In the Message field, type

Get input if not already written

In the Question field, type

What points did you want to focus on?

Select Add Another Tool, select Search Vector DB.
In the Message field, type

Select integration if not already written

In the Query field, type

Pull all relevant content from the meeting notes/transcript that include action items, next steps,
meeting participants, have a focus on the areas covered here $3.output.

Select Step 1 for Select a step to pick integration.

Select Step 2 for Select a step to pick source.

For No of Chunks, type 5

Select Add Another Tool, select Generate LLM Response.
In the Message field, type

Generating Response if not already written
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24. In the Instruction field, type

You are a meeting note taker, using the meeting transcript/notes create a full meeting minutes
report that highlights the main points of the meeting, key takeaways, action items, along with any
other relevant content that would need to be considered.

When outputting the report, create it with this guideline covering these sections in order:
Participants of the Meeting

Executive Summary

Key Points from the Meeting

Action Items

Don’t have to necessarily include all the points mentioned earlier if there is not much data.

Provide result in text format that does not contain tables or other heavy formatting, just basic
formatting like using strictly dashes and spaces only. And include as little formatting as possible
please. And please structure spaces accurately and consistently.

Please provide output that when copied for usage, will provide all the formatting of the
generated results.

Make the final output as short and concise as possible.

25. In the Relevant content field, type $4.output

26. Click Save.

27. Simultaneously start the stopwatch and click the Select Model drop-down menu in the upper-right corner.
28. Select the user.LFM2-2.6B-Transcript-1-GGUF model to load it.

29. Go to Home, search for Meeting Minutes Creator, and open it.

30. Click Local Files option.

31. Click Upload file, navigate to your meeting notes Word file, and upload it.
32. Select the uploaded meeting note file, and click Continue.

33. Provide the main point you want to focus on from the meeting and continue.
34. Wait for it to generate the response.

35. Open Word.

36. Copy the generated meeting notes summary, and paste it into Word.

37. Simultaneously stop the stopwatch and save the Word document.

38. Record the time.

39. Repeat steps 1 through 38 two more times.

Traditional workflow

1. Simultaneously start the timer and open the meeting transcript with Word.
2. Read through the entire document carefully, identifying:

e Participants of the meeting
e Executive summary
e Key points from the meeting

e Action items

3. Highlight or note down the important sections manually.
4. Open a new blank Word document to begin drafting the meeting minutes.
5. Start writing the report using the following structure:

* Participants of the meeting (List all attendees based on the transcript)

* Executive summary (Summarize the overall purpose and outcome of the meeting)

* Key points from the meeting (List major topics discussed and insights shared)

* Action items (Mention tasks assigned, responsible persons, and deadlines if available)
Use only basic formatting: dashes for bullet points and consistent spacing.

Review the document for clarity, conciseness, and completeness.

Simultaneously stop the stopwatch and save the Word document.

Record the time.

o 0 ® N

0. Repeat steps 1 through 9 two more times.
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Reviewing Jira tickets

Installing and setting up Lemonade

Bl

© N oo;

9.

Download Lemonade Server from https://lemonade-server.ai/.
Launch the installation and use the default settings throughout installation.
Finish the installation with the launch option selected.

Wait 10 to 20 seconds for the Lemonade notification to pop up in the lower-right corner of the screen. Lemonade server is now running
in the background.

Right-click the Lemonade icon in the taskbar, and select Open app.
In the search field in the left sidebar, type gpt-oss-20b-mxfp4-GGUF
Select the download button next to the model.

When the download completes, load the newly installed model gpt-oss-20b-mxfp4-GGUF by clicking on the play icon next to
the model name.

Open the taskbar popup and right-Click lemonade. Select Context Size from the menu and choose 16k.

Installing Generate Al PC

ok wbh -~

Open the generateinstaller1216.exe file.

Click through the installation using the default selections.

After installation, launch Generate.

Enter your username, password and license key when the application loads the Register page.

From the Select Model drop-down menu in the upper-right corner, select gpt-oss-20b-mxfp4-GGUF.

Close Generate.

Setting up Jira

T30 NO A WDN =

0.
1.

Go to https://www.atlassian.com/software/jira and sign up/login using your account.

Select Continue without two factor authentication.

Select Go to Jira or Jira Service Management.

Note down the URL before /jira/software/projects. For example: https://radteam-lab.atlassian.net.
Click the profile picture on the upper-right corner of the screen, and select Account settings option.
In the upper section of the screen, click Security.

Select Create and manage API tokens, and verify your identity.

Select Create API token, and provide name.

Click Create.

Copy the generated API token, and save it securely.

Click Done, and close the tab.

Adding tickets/work items

akrwbd =

N o

9.
10.
11.

Go back to the Spaces - Jira tab.

Click the MexiCat space.

Go to List view by clicking on the List button under the Mexicat title.

Hover over the Type of the KAN-11 ticket and Click the + button to create a new work item.

Enter the following text in the text box and press create or press the enter key to create the work item. Mobile App Integration
for MexiPetFeeder.

Assign the work item to yourself by clicking on the Unassigned button and selecting the first option from the drop-down menu.
Open the work item by clicking its key.
Add the following description:

Develop and test a companion mobile app feature that allows users to:
- Schedule feeding times remotely.
- Receive push notifications for low food/water levels.
- Track pet feeding history and health metrics.
- Provide firmware update prompts for the feeder.

Click Save.
Close out of the ticket by clicking the x in the upper-right corner.
Create another work item and enter the following title: Feeder Portion Calibration Bug
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12. Click the Type drop-down menu, and select bug.
13. Open the ticket and enter the following description:

During internal testing, some feeders dispense inconsistent portion sizes compared to the programmed
amount. This issue could lead to overfeeding or underfeeding pets.

- Investigate root cause in the dispensing mechanism and firmware logic.

- Validate calibration across multiple units.

- Implement fix and regression test to ensure accuracy.

14. Save the ticket, and close.

15. Create eight more tickets with similar descriptions.

Al-enhanced workflow

1. Launch Lemonade-server.
2. Load the gpt-oss-20b-mxfp4-GGUF model.
3. Open the Generate Al PC application if it is not already running.
4. Click MCP Playground, and select the setting icon beside the JIRA option.
5. Inthe JIRA MCP setting popup, enter the following details:
JIRA-AUTH-TYPE: basic
JIRA-URL: (Type the URL saved in setup).
JIRA-USERNAME: (Type the email address you used to signup/login into JIRA).
JIRA-API-TOKEN: (Copy and paste the API token that you previously saved) .
6. Click Save.

7. Turn on the toggle besides the JIRA option. Jira Chat will open.
8.  Simultaneously start the stopwatch and enter this prompt:

Summarize all Jira issues updated today across all projects and email me the team update.
and click Send.

9. When the output completes, copy the text and paste it into a Word document.
10. Simultaneously stop the stopwatch and save the Word document.
11. Record the time.

12. Repeat steps 1 through 11 two more times.

Traditional workflow

1. Simultaneously start the stopwatch and log into Jira.
2. Open each relevant project.
3. Manually apply a filter:

updated >= startOfDay () AND updated <= endOfDay ()

Review each issue's activity log for changes.

Copy relevant comments, transitions, and new issues and paste them into a Word document.
Manually summarize changes in a Word document.

Write a daily summary draft with the content in the Word document.

When the summary is complete, simultaneously stop the stopwatch and save the Word document.
Record the time.

o 0 o Noo R

0. Repeat steps 1 through 9 two more times.
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Creating a project plan

Installing LLM Studio

Open browser and go to https://Imstudio.ai/download.

Click Download for Windows. Wait for the download to finish.

Launch the installation, using the default settings throughout the installation.

Finish the installation with the Run LM Studio option selected.

Click Ok to close popups.

Click the search icon in the upper-right corner of the app window.

Search for Gemma 3 12B model in the search bar.

Select the matching option, and click the download button on the lower-right corner of the popup. Wait for the download to finish.
Click the Load Model popup, which appears after the model has been downloaded.

0. Wait for the model to finish loading.

S 00N GAEWN =

Installing and setting up Excel

Setting up OneDrive (Required)

1. Search for OneDrive in the search bar, and open OneDrive.
2. Sign in with your Microsoft 365 account.
3. Follow the prompts and finish the setup process.

Installing Excel

1. Search for Excel in the search bar, and open Excel.
2. Click accept on the License Agreement page if prompted.
3. Ensure the Microsoft Account associated with the application has a valid license. If not follow these steps to login to a valid account:

Click the Microsoft Account button beside the Minimize Button.
Click the Sign in with a different account button.

Enter your email. Click next.

Enter your password.

Select No, this app only option.

"o a0 oo

On the Update window popup, click close.
4. Close Excel.

Al-enhanced workflow

1. Simultaneously start the stopwatch and launch LM Studio.
2. Load the Gemma 3 12B model.
3. Type the following prompt:

Make a project plan in Excel to run a mini project to solve a critical problem in final UI design.
Include all roles needed, 4-week duration.

4. Press Enter. Wait for the LLM to complete its response.
5. Review the generated Project Plan for accuracy, conciseness, and key insights.
6. Type the following prompt:

‘ Create a CSV file of the table that I can import into Excel and click enter.

7. Wait for the prompt to finish generating.

8.  Click Copy to copy the generated csv.

9. Open file explorer, and navigate to the extracted AMDTest folder in your C Drive.

10. Click the View drop-down menu located in the top bar.

11.  Click the Show > button to open the drop-down menu, and make sure the File name extensions is checked.

12. Close out of it by clicking anywhere outside the menu.

13. Create a new file by right-clicking anywhere within the empty folder space, hovering or clicking New, and selecting Text Document.
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14. Name the file as updated project plan.txt and click enter.

15. Right-click the file, and click Open to open with Notepad.

16. Paste the copied CSV file produced by the LLM from LLM Studio.
17. Click File, and click Save from the drop-down options.

18. Close out of Notepad by clicking on the X icon in the upper-right corner.
19. Right-click the updated project plan.txt file, and click Rename.

20. Change the file extension from .txt to .csv, and click Enter.

21. In the rename warning popup, click Yes.

22. Open the file with Excel by right-clicking the file and clicking Excel.
23. Ensure the formatting is correct.

24. Simultaneously stop the stopwatch and save the Excel file.

25. Record the time.

26. Repeat steps 1 through 25 two more times.

Traditional workflow

Simultaneously start the timer and open Excel.

Identify Key Tasks/Activities: Brainstorm all the things that need to happen to complete your project.

Break items into appropriate phases (e.g., Planning, Design, Development, Testing, Deployment).

Estimate Task Durations: How long will each task take? Consider dependencies and potential roadblocks.
Assign Resources: Who's responsible for each task? This helps with accountability and workload management.
Define Milestones: These are significant checkpoints in your project — key deliverables or completion of phases.
Review the updated Project Plan for accuracy, conciseness, and key insights.

Update the Excel project plan to include these steps, mapping to the appropriate roles in sheet.

When the project plan is complete, simultaneously stop the stopwatch and save the Excel file.

Record the time.

TS0 NOoC O AEWN =
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Repeat steps 1 through 10 two more times.

Assess impacts - Create a Gantt Chart in Excel

Al-enhanced workflow

Launch Excel with Copilot.

Simultaneously start the stopwatch and open the project plan Project Plan MexiCat MexiPet.xIsx.
Select the toggle button beside AutoSave, located near the upper-left corner, to enable auto save.
In the popup, select the OneDrive account created in setup.

On the Automatically saving popup that appears, select Got it.

In the ribbon, click Copilot .

Enter the following prompt:

Nouankrowbd~

Give me the steps to make a Gantt chart of tasks from this sheet

8.  Review the generated summary for accuracy, conciseness, and key insights.

9. Expected result:

To create a Gantt chart using the data in the table-like range A1:N77 on the MexiCat GuacCat Tableau
2 sheet, follow these steps:

Steps:

Prepare the Data:

Ensure the columns Task, Start Date, and End Date are properly formatted. The Start Date and End
Date columns already use the m/d/yyyy format.

Insert a Stacked Bar Chart:

Select the Task, Start Date, and Duration columns (Duration can be calculated as =DATEDIF (Start
Date, End Date, d) if not already present).

Go to the Insert tab and choose a Stacked Bar Chart.

Format the Chart:

Set the Task column as the vertical axis (categories).

Use the Start Date as the first series and Duration as the second series.

Format the Start Date series to be invisible (no fill) to create the Gantt chart effect.
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Adjust the Chart:

Reverse the order of tasks on the vertical axis.

Format the horizontal axis to display dates.

Let me know if you need detailed instructions for any step!

10. The summary should accurately capture the main points of the document in a well-organized format (e.g., headings, bullet points).
11. Follow the steps to create a Gantt chart.

12.  Stop the stopwatch when the Gantt chart is created.

13. Record the time.

14. Repeat steps 1 through 13 two more times.

Traditional workflow

Launch Excel (no Copilot).

Prepare the stopwatch.

Simultaneously start the stopwatch and open the project plan Project Plan MexiCat MexiPet.x|sx.
In the menu bar, click Help.

In the ribbon, click Help.

oA wWN =

Enter the following prompt:

Give me the steps to make a Gantt chart of tasks from this sheet

7. Review the static help text for accuracy, conciseness, and key insights.
8.  Expected result:

A Gantt chart illustrates a project schedule. It primarily has four columns: task, start date, end
date, and duration. To find Gantt chart templates, follow these steps:

On the File tab, select New.

Select a Gantt chart from the gallery, or type Gantt charts into the Search for online

templates field.

Choose a chart and follow the prompts to download. Customize the Gantt chart with your

own data and save.

9. On the left side of the window, click New.

10. In the search bar in the main window, type Gantt Chart
11. Select the Simple Gantt chart template.

12. Click Create.

13. While referencing the support resources, replace the data in the Simple Gantt chart with the correct fields from the Project Plan
MexiCat MexiPet.xIsx.

14. Ensure the data is structured as explained in support resource.
15. Stop the stopwatch when the Gantt chart is completed.

16. Record the time.

17. Repeat steps 1 through 16 two more times with different users.

Updating a presentation

Setting up PowerPoint

Launch PowerPoint.

Click to accept the License Agreement if prompted.

Sign in with a Microsoft Account that has a valid license.

Close PowerPoint.

Relaunch PowerPoint.

In the navigation bar on the left side of the app window, click Open.

Click Browse.

Navigate to the mexicat_presentation.pptx file from the mexicat folder in the zip file, and open the file.
Accept the License Agreement if prompted.

0 0Nk wWwDN =
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Setting up Word

® Nk wh =

Launch Word.

Click to accept the License Agreement if prompted.

Sign in with a Microsoft Account that has a valid license.

Close Word.

Relaunch Word.

In the navigation bar on the left side of the app window, click Open.

Click Browse.

Find Press Release_MexiCat Launch.docx file from mexicat folder inside the extracted folder, and open the file.

Al-enhanced workflow

Open mexicat_presentation.pptx and mexicat_press_release.docx.

In Power Point, simultaneously start the stopwatch and Insert a new blank slide by clicking on the New Slide drop-down button within
the Slides section in the tab above, then clicking on the BLANK slide from the drop-down menu.

Switch to the slide with the title Background (slide 7 after new blank slide), and use the Click to Do (Windows key + Q) feature to select
the image of a black cat smiling.

In the Click to Do drop-down menu, select Blur Background with Photos.

When the image file of the selected photo pops up on the right pane, select Replace.

Click Save options.

In the drop-down menu, click Copy to Clipboard, and minimize the popup (don’t close it).

Go to the new blank slide created earlier, and paste the newly edited white background image to the right side of the slide.
Minimize the PowerPoint application (don't close it).

Go to the mexicat_press_release.docx window.

Make the entire document visible by switching to the View tab and clicking on Multiple Pages within the zoom section.
Open Click to Do with (Windows key + Q).

Select the Rectangular selection tool at the top.

Highlight the entire document using the rectangular selection tool.

In the drop-down menu that appears, select Create a bulleted list.

After the bulleted list is generated, in the lower-right corner, click Copy.

Click the x button at the top to close out of Click to Do.

Paste the bulleted list into the blank slide within the mexicat_presentation.pptx file.

Format the bullet points correctly.

Select Save as, and enter the following title: updated mexicat presentation.pptx

Simultaneously stop the stopwatch and select Save.

Record the time.

Repeat steps 1 through 22 two more times.

Traditional workflow

N —
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11.
12.
13.
14.
15.

Open mexicat_presentation.pptx and mexicat_press_release.docx.

In PowerPoint, simultaneously start the stopwatch and insert a new blank slide by clicking on the New Slide drop-down button within
the Slides section in the tab above, then clicking on the BLANK slide from the drop-down menu.

Navigate to slide with the MexiCat Image. Right-click the image (smiling black cat), and select Copy.
Open Microsoft Paint.

Paste the copied image into Paint.

Shrink the borders to match image size.

Select Remove background in the upper-left area of the ribbon bar in the Paint within the Image section.
In the Tools section of the ribbon bar, select Fill.

Select the white circle in the Colors section, and click the background of the image.

In the Selection section of the ribbon bar, click the drop-down menu, and click Select all.

Right-click the now highlighted modified image, and then click Copy.

Navigate back to the mexicat_presentation.pptx window.

On the blank slide you created earlier, right-click, and paste on the right side of the slide.

Navigate to mexicat_press_release.docx, and read the document.

Place the windows for PowerPoint and Word Doc side by side.
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16. Type the following bullet points into the PowerPoint slide that has the edited cat image:

PurrrdyAmazingCompany launched MexiCat, an automatic cat food dispenser.

It serves Mexican-themed food designed specifically for cats.

Features include: customizable portions, a programmable schedule, a voice recorder, and
an anti-tip base.

The company plans to expand the product line with other international cuisines.

17. Select Save as, and enter the following title: updated mexicat presentation.pptx
18. Simultaneously stop the stopwatch and select Save.

19. Record the time.

20. Repeat steps 1 through 19 two more times.

Managing client communication and scheduling meetings

Setup

Initial setup

1. Download and extract the workflow folder to the C drive.
2. If the folder is already extracted, move it to the C drive.
3. Do not modify or rename any files.

4.  Follow timing instructions when noted.

Installing Adrenalin

Go to https://www.amd.com/en/support/download/drivers.html.
Click Download Windows Drivers.

Open the downloaded executable.

Click Accept & Express Install.

Wait for installation to complete.

oA wWN =

Restart the system when prompted.

Lemonade Server

Installation

1. Download Lemonade Server from https://lemonade-server.ai/.

2. If the Windows protected your PC popup appears, click More info.
3. Click Run anyway.

4. Proceed through installation using default options.

5. Ensure Run Lemonade Server now is checked.

6. Wait 10 to 30 seconds for Lemonade to start.

Changing context size to 16K

Open the system tray.

Click the Lemonade icon.

Set Context Size to 16k.

Confirm the update notification appears.

Pwbd-=
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Downloading and loading models

1. Open the system tray, and click the Lemonade icon.

2. Click Open app.

3. Search for Qwen3-4B-Instruct-2507-GGUF.

4.  Click Download.

5. Wait for the download to finish.

6.  Close the download popup.

7.  Load the model.

8.  Repeat the steps to download and load Qwen3-Embedding-0.6B-GGUF.
9. Ensure both models show as loaded.

10.  Minimize or close the app.

Node.js

Installation

1. Go to https://nodejs.org/en/download.

2. Click Windows Installer (.msi).

3. Open the installer.

4. Proceed through installation without modifying any options.

Verification

1. Open a terminal window.

2. Enter:
node --version
3. Confirm version output appears.
4. If an error occurs, restart the system.
5. After restarting, start Lemonade Server again.
6. Close the terminal.

Azure

Registering the application

Sign up or log in at https://azure.microsoft.com/en-us/.

Search for App registrations.

Click New Registration.

Enter an application name.

Select Accounts in any organizational directory and personal Microsoft accounts.
Set Redirect URI to: http://localhost:5678/rest/oauth2-credential/callback

Click Register.

Noak,rowbd-~

Storing the client ID

1. On the app overview page, copy the Client ID.
2. Storeitin a text file.

Creating the client secret

Click Certificates & secrets.

Under Client secrets, click + New client secret.
Enter a description.

Click Add.

Wait for the key to generate.

aroDnN -

Complete complex tasks in much less time by using Al technologies on new PCs featuring AMD Ryzen processors April 2026 | 16


https://nodejs.org/en/download
https://azure.microsoft.com/en-us/

Storing the client secret

1. Copy the Value of the new secret.
2. Storeitin a text file.
3. Ensure both Client ID and Client Secret are available for later steps.

Outlook

Setup

1. Open Outlook.

2. Log in with the account used for sending and receiving workflow emails.
3. Open To Do from the left sidebar.

4.  Review the interface.

n8n

Installation

Navigate to the n8n folder inside the extracted AMDTest directory.
Open the installation file.
Wait 2 to 3 minutes for package installation.

PwbN =

Refresh the browser page if needed.

Signup

1. Access n8n at http://localhost:5678.
2. Sign up using any email address.
3. Skip customization by clicking Get Started.

Activation

Accept the free license key.
Check email for activation message.
Click Activate License Key.

Pwbd -

Confirm registration.

Importing the workflow

Return to the home page.

Click Start from scratch.

Click the ... button.

Select Import from File....

Navigate to C:\AMDtest\n8n.

Select n8n-workflow-power_user-2.1.json.

cunewN =

Fixing nodes

Lemonade Chat

Open the Lemonade Chat Model node.
Click Create new credentials.

Click Save.

Confirm successful connection.

arMeDN -

Close the node.

Microsoft Outlook Trigger

Open the node.

Create new credentials.

Enter the Client ID and Client Secret from Azure.
Click Connect my account.

arwDN =

Log in with the Outlook account.
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Accept agreements.

Close the popup.

Reopen the node if errors appear.
Recreate filters manually if needed.
0. Close the node.

3 0 ™ N

Creating a task

Open the node.

Create new credentials.

Enter Client ID and Client Secret.
Click Connect my account.

Log in with the same Outlook account.
Reopen the node if errors appear.
Select Tasks under List Name or ID.

© Nk wd =

Close the node.

Creating folders

1. Open the node.
2. Confirm that there are no errors.
3. Close the node.

Getting inbox folder

1. Open the node.

2. Select the previously created Outlook credential.
3. Close the node.

Searching for children folders

1. Open the node.

2. Confirm no errors.

3. Close the node.

Validation

1. Confirm all nodes show no errors.

Saving and publishing workflow

areDN -

Click Save in the upper-right corner.
Confirm notification appears.

Click Publish.

Confirm version.

Close popups.

Setting up RAG

1. Click the drop-down menu near Execute workflow.
2. Select from Upload your client information here.
3. Click Execute workflow.

4.  Click Choose Files.

5. Navigate to C:\AMDtest\n8n.

6.  Select MexiCat_Project_Content.docx.

7. Click Submit.

8.  Confirm Workflow executed successfully.
Validation

1. Confirm the workflow is saved and published.
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Al-enhanced workflow

Identifying high-priority messages
Set Timer — Start.

Log into a separate email account.
Send an email to the Outlook account.
Open n8n.

Click Executions.

Review execution metrics.

Open Logs to view node input and output.
Wait for the workflow to complete.
Open Outlook.

0. Check the High subfolder.

1. Open To Do to view the assigned task.

TSV NO RN =

Identifying normal-priority messages

1 Send a new email.

2. Wait for workflow execution to complete.
3. Check Outlook for the response.

4. Check To Do for the generated task.

Identifying spam/non-reply emails

1. Send a new email.
2. Invalid emails will be moved to the Notification subfolder.

Identifying low-priority messages
Send a new email.

Wait for workflow execution to complete.
Check Outlook for the response.

Check To Do for the generated task.

Set Timer — Stop.

areDN -

Manual workflow

Set Timer — Start.

Read new unread emails.

Classify each email as high, normal, or low priority.

Send an acknowledgment email including expected response time:

Mo

e High: within 2 hours

* Normal: within 2 business days

e Low: within 7 business days

Write a title and description for a task.
Create a task in the To Do app.
Attach the email to the task.

Set Timer — Stop.

® N o
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Multi-tasking in meeting

Initial setup
1. Go to Settings - System > Display = Brightness and adjust it to 35%.

Installing and setting up Lemonade

1. Download and install Lemonade Server from https://lemonade-server.ai/.
2. Launch Lemonade Server.

3. Ifyou don't see Lemonade in Taskbar, go to Settings - Personalization = Taskbar >Under other system tray icons, turn on Lemonade
(Named - Python), So that, it will appear in Taskbar.

4. If this is your first run, right-click the Lemonade icon in your taskbar, and select Model Manager.
5. Click the llama.cpp category under the BY RECIPE panel. Scroll to find gpt-oss-20b-mxfp4-GGUF, and download it.
6.  Click the FastFlowLM NPU category under the BY RECIPE, find Llama-3.2-3B-FLM, and download it.

Setting up Procyon

1. Buy, download and install Procyon from https://benchmarks.ul.com/procyon/office-productivity-benchmark.
2. Open it, login, and provide a license key.

Manual GPU-enhanced workflow

Launch Teams, and log in with your account.

Click the Meet tab on the left side, click Create a meeting link, and click Create and copy link.

In the Meeting links section, Click Join, and make sure the camera is turned on.

Click Video effects.

In the Backgrounds section, choose any option of your preference, turn the Microphone off, and Click Join now.
Minimize Teams.

Launch Lemonade server.

© Nk w2

Open terminal and run:

python \C:\AMDTest\Teams Meeting\lemonade2.py

9. Minimize the terminal.

10. Go to the Procyon_loops_then_export_PDF.ps1 file inside the Teams_Meeting folder of the extracted AMDTest folder, select and right-
click the file, and select Run with PowerShell.

11.  Enter the path to the location for storing the benchmark result, and click Enter.
12. Enter the number of times you want the benchmark to run (i.e. 5), and click Enter.
13. Enter the base filename for the result PDF, and click Enter.

14.  Wait for the benchmark to finish.

15. Once the benchmark completes, go to the location for the result files.

16. Return to the terminal, stop the LLM by pressing CTRL+C, and exit.

17. Leave the Teams meeting, and close all applications.

18. Repeat steps 1 though 17 two times.

Testing productivity while simultaneously running a large language model

Initial setup
1. Go to Settings > System > Display > Brightness and adjust it to 35%.

Setting up Lemonade

1. Download and install Lemonade Server from https://lemonade-server.ai/.
2. Launch Lemonade Server.

3. If you don't see Lemonade in Taskbar, go to Settings - Personalization - Taskbar > Under “other system tray icons”, turn on
Lemonade (Named - Python), So that, it will appear in Taskbar.

4. If this is your first run, right-click the Lemonade icon in your taskbar, and select Model Manager.
In the BY RECIPE panel, click the llama.cpp category. Scroll down to gpt-oss-20b-mxfp4-GGUF, and download it.
6. In the BY RECIPE panel, click the FastFlowLM NPU category. Scroll down to Llama-3.2-3B-FLM, and download it.

o
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Setting up Procyon

1. Buy, download, and install Procyon from https://benchmarks.ul.com/procyon/office-productivity-benchmark.
2. Openit, login, and provide a license key.

Setting up workflow prerequisites

1. Go to Microsoft Store, download Python 3.13, and install it.
2. Open terminal, and run this command to install openai:

‘ pip install openai ‘

Al NPU-enhanced workflow

1. Run Windows PowerShell with administrator access and run this command:

‘ Set-ExecutionPolicy RemoteSigned

Launch Teams, and log in with your account.

Click the Meet tab on the left side, click Create a meeting link, and click Create and copy link.
In the Meeting links section, click Join, and make sure the camera is turned on.

In the Backgrounds section, click Video effects, and choose any option.

Turn the microphone off, and click Join now.

Minimize Teams.

Launch Lemonade server.
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Open terminal and run:

python .\C:\AMDTest\Teams Meeting\lemonade3.py

* (In some cases, you'd have to use “py” instead of “python” in the command.)

10. Minimize the terminal.

11. In the Teams_Meeting folder of the extracted AMDTest folder, select the Procyon_loops_then_export_PDF.ps1 file, right-click, and select
Run with PowerShell.

12.  Enter the path to store the benchmark result to, and click Enter.

13. Enter the number of times you want the benchmark to run (i.e. 5), and click Enter.
14. Enter the base filename for the result PDF, and click Enter.

15. Wait for the benchmark to finish.

16.  Once the benchmark completes, go to the location you provided for the result files.
17. Go back to the terminal, stop the LLM running by pressing CTRL+C, and exit.

18. Leave the Teams meeting, and close all applications.

19. Repeat steps 1 through 18 two more times.
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Al GPU-enhanced workflow

1. Run Windows PowerShell with administrator access and run this command:

Set-ExecutionPolicy RemoteSigned

Launch Teams, and log in with your account.

Click the Meet tab on the left side, click Create a meeting link, and click Create and copy link.
In the Meeting links section, click Join, and make sure the camera is turned on.

In the Backgrounds section, click Video effects, and choose any option.

Turn the microphone off, and click Join now.

Minimize Teams.

Launch Lemonade server.
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Open terminal and run:

python .\C:\AMDTest\Teams Meeting\lemonade2.py

* (In some cases, you'd have to use “py” instead of “python” in the command.)

10. Minimize the terminal.

11, In the Teams_Meeting folder of the extracted AMDTest folder, select the Procyon_loops_then_export_PDF.ps1 file, right-click, and select
Run with PowerShell.

12.  Enter the path to store the benchmark result to, and click Enter.
13. Enter the number of times you want the benchmark to run (i.e. 5), and click Enter.
14. Enter the base filename for the result PDF, and click Enter.

Wait for the benchmark to finish.
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